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Einführung
SeaClear ist ein PC Rasterkarten-Plotter. An ein GPS angeschlossen, zeigt er das Schiff auf der Karte 
und viele weitere Informationen im Navigationsfeld. 
Die Karten in SeaClear sind Bitmap gerastert. Im Handel erhältliche BSB/KAP und GEO/NOS 
Digital-Karten oder vom Papieroriginal eingescannte, können verwendet werden. 
Im Fahrbetrieb bewegt sich die Karte, um das Schiff immer anzeigen zu können und weitere Karten 
werden, wenn nötig geladen (falls diese Funktion gewählt wurde). 
Routen können ganz einfach erstellt werden und helfen bei der Navigation. Bei Aktivierung einer 
Route  kann damit ein Autopilot angesteuert werden.   
Tracks (Verlaufsspuren) können dargestellt, als Datei gespeichert oder als Route umgeschrieben 
werden. 
Waypts-Datenbanken mit Wegepunkten können rasch abgerufen werden, um 
Wegepunktinformationen zu erhalten oder eine Route zu erstellen. 
Um so weit wie möglich Platz für Karten im Fenster zu haben, kann mit der rechten Maustaste ein 
Popup-Menü mit den meisten Funktionen geöffnet werden.  
Das "Dashboard", die Navigationsleiste zeigt Daten des GPS, der aktiven Route und weiterer Status 
Informationen. Um das Kartenfeld zu erweitern kann diese Navigationsleiste weggeklappt werden.  
Mit der Navigationsleiste werden viele Funktionen kontrolliert. Im Manuellen Modus können über das 
Hauptmenü viele weitere Funktionen bearbeitet werden.  
Falls keine GPS-Daten empfangen werden, kann über das “DR” Feld, direkt Geschwindigkeit und 
Richtung eingegeben werden und SeaClear errechnet in “live”-Zeit die aktuelle Position. Mit dieser 
Funktion ist auch Simulationsmodus möglich. Sind über die NMEA Schnittstelle Bootsgeschwindigkeit 
oder Kursdaten (Elektronischer Kompass) vorhanden, können diese Daten das DR-Feld aktualisieren. 
Der Mouse-Zeiger verändert sich, um die jeweilig mögliche Funktion anzeigen zu können.  
Die Kopfzeile zeigt die geladene Karte, Maßstab, Zoom und Anzahl der Entfernungsringe. 
Die meisten Informationen können ausgedruckt werden.  
Alle Listen können direkt als eigene Dateien gespeichert werden. 
 
AIS-Signale werden auf der Karte dargestellt sobald NMEA Daten von einem AIS Sender oder AIS 
Empfänger übermittelt werden.

Beachte: Alle Hinweise für SeaClear oder MapCal in dieser Anleitung basieren auf die aktuelle Version von SeaClear_2.EXE 
und MapCal_2.EXE. Gegenüber der älteren Version haben sich die Dateinamen geändert, um ein Miteinander im selben 
Verzeichnis zu ermöglichen, wobei aber nur eine Kartenplotter.exe auf das GPS reagieren kann.
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Screen

Kopfzeile

Navigationsleiste

GPS (Schiff)

Karte

Kartenfenster

Wegepunkt Marker Distanz Ringe wahre Fahrtrichtung GPS (Schiff)

Routen Wegepunkt Routen Linie Windpfeil
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Navigationsleiste

Hauptmenü
GPS Status. Das Fenster  wird rot dargestellt, falls keine GPS Daten eingehen 
Latitude / Longitude 
Wahrer Kurs über Grund 
Geschwindigkeit über Grund 
Computer berechnete Magnetische Missweisung  / Welt-Zeit vom GPS 
GPS basierendes Log 
Trip 
Software Laufzeituhr 
Wegepunkt Datenbank 
Wähle Wegepunkt 
Finde diesen auf der Karten, lade neue Karte falls nötig  
 

Routen Schnellbefehle

Statistik der benutzten Route

Tiefenanzeige. Bei Anschluss eines NMEA Tiefenmessers. Schaltet auf rot im 
Alarmfall 

 Wind Informationen. Bei Anschluss eines NMEA Windmessers 
Wahre Richtung und Geschwindigkeit 
Relative und Geografische Richtung 
Parallelberechnung zum Wind 
Magnetischer Kompass. Bei Anschluss eines NMEA Elektronik-Kompass 
 AIS Informationen
 Auswahl eines AIS Zieles
Wähle Messen oder Zentrierung bei Doppelklicken der Maus in der Karte  
 Beim „Messen“ ist die Farbe  Grün. 

Beim „Marker setzen“ ist die Farbe Cyan.
Wähle Nachtabdunkelung des Bildschirms 
Klicke um den Automatikmodus Ein/Aus zu schalten (ACHTUNG: Datei / 

Bearbeiten verschwindet)
Klicke um den Trackmodus Ein/Aus zu schalten 
Bei aktiver Route, klicke um NMEA Datenausgang Ein/Auszuschalten 

Cursor / Messen / Marker Wegepunkt, Richtung und Entfernung. 

Nur beim Anschluss der jeweiligen NMEA-Geräte werden die Datenfelder dargestellt. Auch ein 
kleinerer Bildschirm kann die Anzeige begrenzen. Um alle Daten anzeigen zu können brauchen sie 
einen 1024 x 768 Pixelbildschirm, sonst können diese nicht alle Felder dargestellt werden
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Planen mit SeaClear

Computer-Berechnete Navigation hat viele Vorteile. Der PC oder die benötigten Dateien können von 
Bord genommen werden und eine weitere Planung kann in Ruhe, auf diesem oder einem anderen 
Rechner, vorbereitet  werden. Karten können schnell und einfach gescannt werden, wichtige 
Wegepunkte bezeichnet und die nächste Route(n) sorgsam geplant und gespeichert werde.
Bedienung
Während der Planung muss der AUTOMATIK-Modus AUS sein.  Der Cursor ist dann ein Kreuz.

Die Augenblickliche Cursorposition relativ zum Boot wird in der Navigationsleiste unten angezeigt. 
Um die geladene Karte zu bewegen, klicken sie irgendwo in die Karte, halten die Linke Maustaste 
und verschieben sie. Im  “Center” Modus wird bei Doppelklicken die beste Karte für den Cursorpunkt 
geladen. Falls die Karte bereits die höchste Auflösung ist, wird sie erneut zentriert um ein rasches 
Zurechfinden zu ermöglichen.  
Bei “PC-Maus mit Rad” kann mit diesem schnell gezoomt werden. Dabei wird um die Mouse-
Position gezoomt. 
Um Karten zu suchen, klicken sie rechts, dann in das Karten Menü und wählen eine neue Karte. 

Befindet der Cursor sich am Kartenrand, verändert er sich in ein Pfeilkreuz.  Es zeigt den 
Karten-Such-Modus an. Mit einem Links Doppelklick, lädt die Software die Anschlusskarte. Falls 
nicht vorhanden lädt sie die Karte mit kleinerem Maßstab. Dies funktioniert auch im Messbetrieb 
oder im Routen Editor Modus.  
Klickt man auf das GPS Koordinatenfeld, wird auf der Karte das Boot zentriert. Sollte das Boot nicht 
auf der aktuellen Karte sein, wird automatisch die beste Karte geladen. Doppelklicken in der Karte 
lädt die beste Karte. 
Falls “Messen” in der Nav-Leiste aktiviert ist, kann mit Doppelklick, Halten & Ziehen Entfernung und 
Richtung gemessen werde. Dies wird in der Nav-Leiste unten (grün unterlegt) angezeigt. 
Doppelklicke sie am Startpunkt und halten die Musetaste bis zum Zielpunkt gedrückt. Im Automatik-
Ein-Modus ist Messen immer aktiviert. 
Wählt man im Wegepunkt-Menü einen Wegepunkt, wird dieser zentriert dargestellt. Ist er nicht auf 
der aktuellen Karte wird die Beste für diesen Punkt geladen. Unabhängig vom Suchen können 
Wegepunkte als neue Routenpunkte verwendet werden. Routen können gewählt werden und auch 
mehrere kleine Routen als Gesamtroute zusammengefasst  werden. 
Routen, Wegepunkte und andere Informationen können ausgedruckt oder als Text-Dateien 
gespeichert werden. Alle Listen werden als Komma-Getrennte-Dateien gesichert und können mit 
vielen anderen Anwendungen geöffnet werden.

Wegepunkt (Waypoint)
Wegepunkte können gleichzeitig als “besonderen Punkt” oder als Routen-Wege-Punkt genutzt 
werden. Damit verbunden können Routen als Wegepunkte geöffnet werden, z.B. um Teile der Route 
neu zu nutzen. Wichtig ist die Vergabe von Wegpunkt-Namen, wobei Namens-Duplikate nicht 
möglich sind.  
Um einen neuen Wegepunkt zu speichern, klicke sie die 
rechte Maustaste an dieser Stelle auf der Karte und 
wählen Wegpunkt > Hinzufügen, tragen Wegepunktname 
und evtl. weitere Infos ein.  Nachbearbeitung bereits 
vorhandener Wegepunkte ist nach der Auswahl im 
Positions-Fenster der Nav-Leiste möglich.  Mit einem 
Doppelklick im Wegepunktnamen, oder nach Anwahl von 
Datei > Wegepunkte > Entsperre, ist es möglich die 
Position Weiterzuziehen und mit einem Doppelklick den 
Editor zu öffnen. Zum Löschen muss nur die Rechte Maustaste gedrückt werden..
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Routen
Allgemein 
Eine Route ist eine Aneinanderreihung von Wegepunkten, verbunden mit Geschwindigkeits- und 
XTE Infos.  Bei Aktivierung einer Route werden die wichtigsten Daten dazu in der Navigationsleiste 
angezeigt. 
Routenerstellung 
Routen werden im Routen-Editor (Hauptmenü: Bearbeiten > Routen Editor) erstellt oder geändert. 
Die Navigationsleiste ändert sich für Information von ausgewählten Wegepunkten und 
Schnellschaltern. Das Hauptmenü ist dabei verdeckt. 
Beachte: Eine aktive Route muss vorher deaktiviert sein..

Der Cursor wird dabei als Einfügemodus:  oder im erweiterten Modus:   dargestellt.
Neue Wegepunkte werden einfach mit Doppelklick der linken Maustaste erstellt, oder können der 
bereits gespeicherten Waypts-Datei entnommen werden.  
Während dem Einfügemodus (normal) wird die Nächste, bereits Existierende mit dem neuen Punkt 
verbunden. Vergessen sie dabei nicht die sofortige Namensbezeichnung und mit update zu 
speichern. Im erweiterten Modus wird der Wegepunkt an das Ende der Route gehängt. 
Nachträglich bewegt werden können die Wegepunkte durch einfaches Hineinklicken, halten und 
verschieben zur Neuen Position (Wichtig: sofort update klicken falls sie den Namen ändern). 
Nachbearbeitet können diese Wegepunkte im oberen Teil der Navigationsleiste werden. Mehrere 
Wegepunkte können mit der Ctrl-Taste oder der Shift-Taste angewählt oder abgewählt werden. Die 
ausgewählten Wegepunkte können gelöscht oder nachbearbeitet werden. Während der Änderung 
von Mehrfach-Wegepunkten können aber keine Koordinaten oder leere Felder bearbeitet werden. 
Dies ist aber im Route-Listen Feld möglich.  
Während der Routen Editor aktiv ist, sieht die Navigationsleiste so aus:

Routen Hauptmenü 
Ausgewählte Positions-Datei 
Liste von Wegepunkten 
 Position Latitude 
Position Longitude 
 
Geschätzte Geschwindigkeit 
Max Kursversatz 
 
Wegepunktname 
Update sofort nach jeder Änderung 
Lösche Auswahl 
Schnellschalter 
 
  
 
Füge ausgewählte Wegepunkte an die Route 

Waypoint Datei 
 
 
Geladene Routen Statistik

Wenn ein Wegepunkt aus der Liste gewählt wird, ist dieser sofort zentriert auf dem Kartenbildschirm 
dargestellt. Befindet er sich nicht auf der momentanen Karte, wird die best mögliche Karte dafür 
geladen.
BEACHTE: Während der Arbeit im Routen Editor werden die GPS Daten weiterhin von SeaClear verarbeitet..
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Navigieren mit SeaClear

Bevor ein Törn begonnen wird, sollte die benötigte Route geladen werden. Nun ist es möglich 
SeaClear unabhängig arbeiten zu lassen und sie haben Zeit für andere Arbeiten. Während der 
Navigation kann der AUTOMATIK-Modus aktiviert werden. Die Karte wird dabei ständig neu 
verschoben und auch weitere Karten automatisch geladen, um das Schiff ständig im Kartenmittelpunkt 
(falls gewählt) zu sehen.  
Falls eine Route geladen wurde, aktivieren sie diese um weitere Information zu erhalten. Ist das 
Tracking aktiviert, wird die Trackspur eingezeichnet und automatisch gespeichert. 
Im AUTOMATIK-Modus ist der Cursor der gewohnte Pfeil. 

Navigation mit Routen 
Laden sie, bevor ein Törn begonnen wird, die nötige Route (n). Mehrere Routen können ausgewählt 
werden und jede weitere Route wird an bestmöglicher Position angehängt. Gleichzeitig mehrere 
Routen können mit  der Shift-Taste ausgewählt werden. 
Bei einer Aktivierung im letzten Teilstück einer Route wird diese automatisch umgekehrt. Ist das Boot 
nicht am Start- oder Zielpunkt wird von der momentanen Position aus gerechnet. 
Falls die Route aktiviert ist, wird der neue Zwischen-Ziel-Punkt hervorgehoben (Rechteck) und in der 
Navigationsleiste erscheinen dazu weitere Daten.  Ist im AUTOMATIK EIN-Modus der “NMEA OUT”-
Schalter aktiviert, werden die im Setup ausgewählten Datensätze an externe Geräte (z.B. Autopilot) 
geschickt:

Wegepunktname 
BWR: Kurssteuerung zum Wegepunkt, Rumb Line
XTE: Kursversatz, 
BOD: Routen-Original-Kurs zwischen den Wegepunkten, 
WCV: Wegepunkt  Annäherungsgeschwindikeit 
RNG: Entfernung zum Wegepunkt, 
TTG: Zeit bis zum Wegepunkt, 
TRNG: Entfernung zum Routenzielpunkt, 
TTTG: Gesamtzeit bei aktueller Geschwindigkeit zum Ziel. 
NEXT: Nächster Kurs. 
TIME: Zeitanzeige seit die Route aktiv ist. 
____||____: Steueranzeige.

Um zwischen “Wahrer” und Magnetischer” Kursanzeige zu wechseln, öffnet man mit einem 
Rechtsklick das Popup-Fenster auf die Routeninformationen.  
Bei Überschreiten des eingestellten XTE-Wertes (Kursversatz), wird er rot dargestellt. 
Wird der nächste Wegepunkt über- oder umfahren, aktiviert sich der Nächste. Im AUTOMATIK-
Mode muss (Einstellungen?), dies über ein Rechtsklicken im Popup-Menü > Route bestätig werden. 
Wenn der AUTOMATIK-Modus EINgeschalten ist und die Route aktiviert, steht das Hauptmenü 
nicht zur Verfügung. Ebenfalls ist das Wegepunkt-Fenster verschwunden und Änderungen von 
Wegpunkten sind momentan nicht möglich. Die meisten Schnell-Schalter sowie das Zoomen sind 
dagegen in Funktion. Für eine Übersicht kann mit Ctrl-S eine Überfliegerkarte geladen werden. 
Diese schaltet automatisch nach 20 Sekunden auf die beste verfügbare Karte zurück.  
Um die Route zu deaktivieren klicken sie rechts das Popupmenü Route > Route aktivieren.
Tracks (Verlaufsspur)
Falls das Tracking aktiviert ist, wird die Trackspur des Bootes bis 0 Uhr aufgezeichnet und 
permanent gespeichert. Ab 0 Uhr beginnt eine neue Datei, die Alte kann aber nachgeladen werden, 
wobei dazu das Momentan-Tracking Abgeschalten werden muss. Folgende Daten werden 
gespeichert: Datum, Zeit, Positionen, Kurs und Geschwindigkeit. Der Track Intervall kann über das 
Kartenreiter „Log + track“ in Bearbeiten > Einstellungen verändert werden. Die Trackdatei erhält 
automatisch ein ANSI Format mit Datumsangabe (z.B. 20060304.TRC = Jahr 2006, Monat 03, Tag 
04 = 04.03.2002). Die Trackdateien können ausgedruckt oder exportiert werden. Diese Dateien 
können auch als neue Route verwendet werden oder in Google Earth dargestellt werden.
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Logbook
Ein elektronisches Logbuch speichert bei Öffnen automatisch Zeit und Position. Selbsterstellte 
Textteile können daran angehängt werden. Automatische Einträge, Pfad und Logbuchname werden 
über Bearbeiten > Einstellungen eingestellt. Mit jedem Texteditor  kann sie gelesen werden.

Kartengruppen

Um Digitale Seekarten besser organisieren zu können ermöglicht SeaClear Kartengruppen. Sie sind 
optional. Falls keine Gruppe erstellt und gewählt ist, werden ständig alle Karten durchsucht. 
Während eines Suchbefehles werden Karten dieser Gruppen vorrangig gefunden und angezeigt – 
ansonst werden alle Karten aufgeführt. Unabhängig vom Maßstab werden alle Karten in einer 
gewählten Gruppe angezeigt. 
Bis zu 24 Gruppen können erstellt werden. Mehrfachzuweisungen einer Karte sind möglich. 
Gruppen erleichtern das Auffinden einer besonderen Karte, die auch automatisch für Planungen 
(AUTOMATIK AUS) geladen werden kann. 
Die bevorzugten Gruppen im AUTOMATIK-Modus und dem Planungsmodus sind unabhängig und 
erlauben verschiedene Karten im Planungsmodus zu öffnen, ohne sich im AUTOMATIK-Modus 
auszuwirken.

Erstellen und Gebrauch von Kartengruppen
Um eine Kartengruppe zu erstellen wird über das Hauptmenü Bearbeiten > Kartengruppe ein 
Dialogfenster geöffnet. 
Um Gruppen nutzen zu können müssen sie vorher im Gruppen Setup erstellt werden. Benötigte 
Karten für eine Gruppe werden im Verwalte die Karten-Fenster durch Auswahl der Gruppe 
angezeigt. Wählen sie hier nun mit CTRL oder Shift-Taste alle gewünschten Karten aus und 
schicken sie mit dem Mittelpfeil in die gewünschte Gruppe. 

Bevorzugte Autoload-
Kartengruppen werden in diesem 
Fenster ausgewählt. Ist der 
AUTOMATIK-Mode aktiviert, 
können bevorzugte Karten über 
das Popup-Menü geladen werden. 
Im Planungsmodus werden 
bevorzugte Karten mit einem 
Doppelklick geladen. 
Beim Gebrauch der Popup-
Funktion Karten > Suchen sorgt 
eine Vorauswahl für schnelles 
Auffinden. 
Um alle Karten zu aktivieren, 
müssen nur alle bevorzugten 
Gruppen deaktiviert werden. Auch 
nach dem Deaktivieren kann 
individuell in Gruppen gesucht 
werden. 

Die Kartenrandlinie zeigt, vom Maßstab abhängig, verfügbare Karten auf dem Bildschirm oder einem 
Ausdruck. Um aber alle Karten anzeigen zu können, müssen alle Gruppen deaktiviert werden. 
Die im MapCal neu kalibrierten oder gefundenen Karten werden nicht automatisch einer Gruppe 
zugeordnet, können aber nachträglich in ein Gruppe eingefügt werden.  
Im Popup-Menü Karte > An dieser Position werden alle, für diese Position möglichen Karten, 
Gruppenunabhängig angezeigt.

11



SeaClear MMV

Menüs
Menümöglichkeiten sind vom gewählten Modus abhängig. Im Planungsmodus ist das Hauptmenü 
verfügbar. Hier können Dateien geladen werden die zur momentanen Position keinen Bezug haben. 
Popup Menüs, die mit der Rechten Maustaste aktiviert werden, lassen einen schnellen Zugriff auf 
viele Funktionen zu, abhängig welches Menü gerade aktiviert ist.

Normaler Planungsmodus Hauptmenü:
Datei
Karte: 
⇒ Zeige Alle. Zeigt alle Karten der Autoload Liste.

⇒ Suchen: Öffnet den erweiterten Suchdialog.  

⇒ Letzte. Lädt die zuletzt verwendete Karte.

⇒ Nicht Aufgeführte. Öffnet Karten die nicht in der Autoload Liste aufgeführt sind. Sie müssen kalibriert sein.

⇒ Kartenrand: Zeichnet eine Randlinie aller verfügbaren Karten auf der verwendeten Karte.  Nur Karten der 
Autoload Datenbank werden dargestellt. Karten desselben Maßstabs und bis zu 50 x kleinere werden 
dargestellt (dies kann im Setup verändert werden) Die Randlinie, ist der Rand der beim Kalibrieren gespeichert 
wurde. Sind die Karten in Gruppen abgelegt, werden nur bevorzugte Gruppenkarten angezeigt.
⇒ Drucke: Über einen Drucker kann die geladene Karte ausgedruckt werden. Routen, Wegepunkte, Track und 
Kartenrandlinien können dabei nach Auswahl mit ausgedruckt werden... Auch Routenangaben und 
Wegpunktinformationen können als Liste ausgedruckt werden. Der Druckbereich bei Karten, kann der 
Bildschirmbereich oder die ganze Karte sein. Die Druckeransteuerung ist auf maximales Papierformat 
eingestellt, die Voreinstellungen des Druckers werden dabei ignoriert. 

⇒ Drucke Liste: Druckt eine Liste aller Karten mit Eckkoordinaten und Maßstab. 

Route: 
⇒ Öffne. Öffnet eine neue vorbereitete Route. Es können mit der CTRL-Taste auch mehrer ausgewählt und 
gleichzeitig geöffnet werden.    
⇒ Schließe. Löscht eine Route vom Bildschirm     

⇒ Export NMEA. Sendet alle Wegepunkt als  NMEA-Datensatz über den Com Port als WPL und RTE Report. 

⇒ Drucke. Druckt die geladene Routenliste.

Wegepunkt: 
⇒ Öffne. Eine oder mehrere Waypts-Dateien können, mit Halten der CTRL-Taste geöffnet werden.             

⇒ Beachte: Jede Waypts-Datei benötigt einen eigenen Dateinamen.   

⇒ Speichere: Speichert den Wegepunkt in der geöffneten Datei.    

⇒ Speichere als: Öffnet ein Pfadfenster in dem das Verzeichnis (normal ist ..\Waypts) und der Dateiname 
gewählt werden kann.    
⇒ Schließe. Löscht alle aktuellen Wegpunkte vom Bildschirm (nicht aus der Datei).    Entsperre. Erlaubt eine 
Auswahl, Verschieben und Löschen von Wegepunkten (nicht aber im AUTOMATIK ON Modus oder Routen 
Editor).    

⇒ Lösche Auswahl    Import WP+: importiert Komma-Getrennte Wegepunktdateien mit *.txt Endung    Export 
WP+: exportiert Komma-Getrennte Wegepunktdateien mit *.txt Endung    

⇒ Export NMEA. Sendet alle Wegepunkt als WPL Report.     

⇒ Drucke. Druckt eine Liste der geladenen Wegepunkte.

Track: 
⇒ Öffne alten Track. Öffnet einen bereits gespeicherten Track und stellt ihn dar.    

⇒ Import WP+. Wandelt eine WP+ Track Datei in SeaClear Format.    

⇒ Export Text. Sichert den momentan angezeigten Track als Komma-Getrennte Text Datei. Zeit, Position, 
Geschwindigkeit und Tiefe werden gespeichert. Positionen werden dabei als Dezimal-Grad-Werte gespeichert 
um leichter in anderen Programmen verarbeitet werden zu können.   
⇒ Drucke. Druckt je nach Auswahl einen aktiven oder älteren Track als Liste.

12



SeaClear MMV

GPS: 
⇒ Dieses Menü steht nur zur Verfügung wenn die G7ToWin Software installiert ist. 

⇒ Sende an das GPS – Wegepunkt  oder Route. Sendet  ausgewählte Daten an das GPS.

⇒ Lade vom GPS – Wegepunkte, Route oder Track. Lädt Daten vom  GPS.

Karten info: Zeigt Zusatzinformationen zur geladenen Karte. 
Schließe: Beendet SeaClear.

Routen Editor Hauptmenü:
Nacht Modus:  
⇒ Wählt den Abdunkelungsgrad des Bildschirmes. 1 ist normal, 4 ist maximale Abdunkelung.  

Routen Editor: 
⇒ Öffnet den Routen Editor. 

Einstellungen:  
⇒ Öffnet das Optionssetup. 

Kartengruppen:  
⇒ Öffnet das Kartengruppensetup. 

System: 
⇒ NMEA Input Monitor. Schaltet das NMEA input Ansichtsfenster ein/aus.    

⇒ NMEA Output Monitor. Schaltet das NMEA output Ansichtsfenster ein/aus.

über... 
Öffnet das SeaClear Info-Fenster.
>> 
Klappt die Navigationsleiste weg um den ganzen Bildschirm als Kartenfenster zu nutzen. Um die 
Navigationsleiste wieder anzuzeigen, fahre sie mit der Mouse nur zum jeweiligen Rand.

Routen Editor Hauptmenü:
Dateimenü
Route:
⇒ Öffne: Öffnet eine neue bereits erstellte Route. Mehrere Routen können mit CTRL-Taste gleichzeitig 
geöffnet werden.

⇒ Speichere: Speichert Änderungen unter dem bestehenden Dateinamen. Sind mehrere Routen geöffnet 
muss ein neuer Dateiname vergeben werden.

⇒ Speichere als…: Speichere als neue Route.

⇒ Import Track. Lädt einen bereits gespeicherten Track.

⇒ Import. Waypoint+ und G7ToWin Datei import. 

⇒ Export. Waypoint+ und G7ToWin Datei export.  

⇒ Export NMEA: Sende WPL und RTE Dateien an angeschlossene  NMEA Teilnehmer  (z.B. Autopilot).

⇒ Routenliste: Öffnet die aktuelle Routenliste.

⇒ Routenumkehr: Vertauscht Start und Zielpunkt.

⇒ Lösche Route: Entfernt die aktuelle Route vom Bildschirm.

⇒ Drucke: Druckt eine Routenliste.
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Öffne Karte:
⇒ Zeige Alle: Zeigt alle Karten die in der Autoload Liste gespeichert sind.

⇒ Letzte: Öffnet die zuletzt verwendete Karte.

⇒ Nicht aufgeführte: Öffnet Karten die nicht in der Autoload Liste stehen.

⇒ Kartenrand: Schaltet den Kartenrandrahmen ein/aus. Es können nur Karten der Autoload Datenbank 
angezeigt werden.

Öffne Wegepunkt: 
Öffnete eine neue Wegepunktdatei.
Schließe Editor.

Popup Menüs
Die rechte Maustaste aktiviert Popup Menüs. An der aktivierten 
Cursorposition sind nun verschiedene Funktionen möglich, die auch 
teilweise im Hauptmenü abgerufen werden können.
Bevorzugte Karten: 
Wählt bevorzugte Maßstäbe, die im AUTOMATIK- sowie Planungsmodus gewünscht werden, oder 
lädt bevorzugte Kartengruppen, bei Doppelklick  im Kartenfenster. Im AUTOMATIK-Modus werden 
die bevorzugen Kartengruppen aufgeführt. Dabei wird die Karte mit größtem Maßstab gewählt. Mit 
den Up/Down Pfeiltasten kann gewechselt werden, “M” steht für maximalen Maßstab, Esc verlässt 
das Fenster ohne Änderung. Als “Beste Karte” im Menü wird die Karte mit dem größten Maßstab 
behandelt.
Karten: 
⇒ (Nicht möglich im AUTOMATIC Modus).    
⇒ Beste Karte: Findet und lädt die beste, an dieser Position verfügbare Karte.     
⇒ Finde Boot: Findet das Boot und lädt die beste Karte dafür.    
⇒ Kleinerer Maßstab: Wählt eine Karten mit kleinerem Maßstab für diese Position.     
⇒ Vorherige: Schaltet zur zuletzt geladenen Karte zurück.    
⇒ An dieser Position: Alle an dieser Position verfügbaren Karten werden aufgelistet.    
⇒ Suche: Öffnet ein erweitertes Suchfenster für Karten.    
⇒ Alle Karten: Alle installierten Karten werden aufgeführt..
Routen:
⇒ Öffne Route: Alle bereits gespeicherten Routen werden aufgeführt.    

⇒ Routenumkehr: Dreht die Route um und verwandelt den Start- in den Zielpunkt.     

⇒ Aktiviere Route: Aktiviert die geladene Route und zeigt Routeninformation auf der Navigationsleiste.

Wegepunkte:
⇒ Hinzufügen: Fügt einen Wegepunkt an die momentane Cursorposition.     

⇒ Momentane Pos. hinzufügen: Erstellt einen Wegepunkt an der augenblicklichen Bootsposition.     

⇒ Lösche Marker: Löscht den Marker.    

⇒ Setze Marker: Setzt einen Marker an die Cursorposition.    

⇒ Ist ein Marker platziert, zeigt das Marker/Cursor-Fenster dessen Position, Entfernung und Richtung vom 
Boot aus.

Zoom:
Zoom mit einem festen %-Wert. Bei einigen PC-Systemen kann zoomen die Kartendarstellung 
dramatisch verlangsamen, andere reagieren darauf kaum. Zoomen in Zwischenschritten s. 
Shortcuts.
Bearbeiten:
⇒ Logbucheintrag: Ermöglicht einen eigenen Logbucheintrag.    

⇒ Alter Track: Lädt einen alten Track ins Kartenfenster.    

⇒ DR Update. Öffnet das “Dead Reckoning” Fenster. Dies ist nicht möglich wenn ein GPS angeschlossen ist. 
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⇒ Erneuere Bildschirm. Lädt die aktuelle Ansicht erneut.    

⇒ Einstellungen: Öffnet das Programm-Setup-Fenster.    

⇒ Schließe. Beendet SeaClear.

MARKIERE MOB: 
Setzt den Marker an die momentane Bootsposition.

Routen Popup Menu
Wenn im Routenmenü die rechte Maustaste gedrückt wird, ist folgende Auswahl möglich: 
⇒ Beste Karte: Die beste Karte an der Cursorposition wird geladen.
⇒ Mehr Karten: Zeigt weitere Karten an.
⇒ Erweitert:  Alle Routenwegepunkte werden aufgezeigt.   
⇒ Zoom: Stellt den Zoomfaktor ein.

Beachte:  Einige Funktionen sind im AUTOMATIK-Modus oder dem Routen Editor nicht möglich. 

Tastatur Kurzbefehle Shortcuts
Tastaturbefehle werden mit Ctrl (Strg) + Taste oder Funktionstasten gegeben.  

Ctrl+'X': Zoom heraus 

Ctrl+'Z': Zoom hinein 

Ctrl+'A' oder F2:  Automatik Ein/Aus 

Ctrl+'T' oder F3:  Tracking Ein/Aus 

Ctrl+'P' oder F4:  NMEA Out Ein/Aus 

Ctrl+'N' oder F5:  Neuen Wegpunkt bestätigen (falls im Setup gewählt)  

Ctrl+'H' oder F6:  Lösche Marker 

Ctrl+’L’ oder F7:  Logbucheintrag 

Ctrl+’C’ oder F8:  Bevorzugter Kartenmaßstab  

Ctrl+'B' oder F9:  Finde das Boot und lade beste Karte  

Ctrl+'F':  Finde das Boot auf der momentanen Karte  

Ctrl+’S' oder F10:  Kleinerer Kartenmaßstab (Im AUTOMATIC-Modus nur für 20 Sekunden)  

Ctrl+Q:  Karte für diese Position. Im AUTOMATIC-Modus für die GPS Position  

Ctrl+'V' oder F11:  Zuletzt geladene Karte laden 

Ctrl+’O' oder F12:  Kartenrand Ein/Aus 

Ctrl+'D': Navigationsleiste Anzeigen/Wegklappen 

Ctrl+'1': Normale Bildschirmhelligkeit 

Ctrl+'2':  Abgedunkelte Bildschirmhelligkeit (2) 

Ctrl+'3':  Abgedunkelte Bildschirmhelligkeit (3) 

Ctrl+'4': Nacht Bildschirmhelligkeit 
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Einstellungen
Allgemein
Im Optionsmenü können verschiedene Einstellungen 
vorgenommen werden, auf die mit dem Popup- oder 
Hauptmenü zugegriffen werden kann. Ein Verzeichnis-
Setup und Kartensuche muss in MapCal durchgeführt 
werden.

Anzeige
Boot:
Update Intervall:   Bildschirm update Intervall für das Boot 
Farbe:   Farbe für den Bootsmarker und Geschwindigkeitsring. 
Größe:   Größe des Bootmarkers. 
Radar Ringe:   Anzahl der sichtbaren Radar Ringe. 
Ring Abstand:   Entfernung zwischen den Ringen, oder Autowahl für die Maßstabanpassung 
Speed Marker:  Anzahl der Sekunden vor dem Geschwindigkeitsring. Ist bei 0 abgeschaltet.
Sprache:
Sprachendatei:   Wähle sie eine Sprache. Siehe dazu den Sprachen-Teil.
Bildschirmanzeige:
Navigationsleiste:  Linke oder Rechte Seite. 
Zoom mit Mausrad:   Ein/Aus. 
Blicke vorwärts:  Ein = in Fahrtrichtung wird der größere Kartenteil angezeigt.                          

Aus = das Schiff wird auf der Karte zentriert dargestellt. 
Update ohne GPS:  Berechnet über das DR Feld die letzten NMEA Daten weiter. 
Dicker Cursor:  Nutzt einen größeren, sichtbareren Cursor.
Karte:
Kartenvorschau:  Zeit für eine Kartenvorschau im AUTOMATIK-Modus. 
Roll Kartenrand:  Kartenrahmen an dem mit Doppelklicken Anschlusskarten gefunden werden. 
Neuer Kartenzoom:  100% oder zuletzt genutzter Zoom.

Route
Nächster Wegepunkt
Nächster Wpt.   Zeiteinstellung vor dem Erreichen eines Wpt. um den Nächsten zu aktivieren. 
Max. Abweichung.   Distanzabweichung zum aktiven Wegepunkt, falls das Boot einen anderen 

Kurs fährt, als die Vorgaberoute und ein neuer Zwischenstarpunkt kalkuliert 
wird. 

Bestätige neuen Wpt:  Falls gewählt, muss bei Erreichen eines Wpt., das nun rote Routenfeld mit 
einem Rechtsklick im Routenfeld oder der Tastatur (F5) bestätigt werden.

Routen Normalangaben
Geschwindigkeit:   Die erwartete Geschwindigkeit beim Erstellen eines Wegepunktes. 
 XTE max.:   Die erwartete XTE maximal Abweichung des obigen Wegepunktes.
Routenanzeige
Normale Farbe:   Farbwahl für die normale Anzeige eines Wegepunktes. 
Ausgewählte Farbe:   Farbwahl für die Hervorhebung eines Wegepunktes.  
Größe:   Marker Größe. 
Linienstärke:   Wahl der Linienstärke. 
Zeige Wegepunktinfo   Zeigt den Wegepunktnamen, falls vergeben, auf der Karte.
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Logbuch + Track
Tracking Intervall:
Einträge der Angaben, wie oft die Bootsposition in der Track-Datei gespeichert wird.  
Min. Zeit.   Zwischen jedem Trackpunkt. 0 ist kein Eintrag. 
Min. Entfernung   In Metern. 0 ist kein Eintrag. 
Kurswechsel   In Grad. 0 ist kein Eintrag. 
All Angaben, ausgenommen 0-Werte müssen vor der Aufzeichnung gemacht werden.
Track Anzeige:
Track Farbe.
Track Darstellungsbreite .
Log Buch:
Automatische Einträge  Was wir automatisch im Logbuch festgehalten. Wählen sie! 
Logbuch-Datei.   Dateiname und Pfad für das Logbuch..

Instrumente
Tiefen Anzeige: 
Zeige Tiefe:   Ein/Aus. 
Tiefen Alarm.   Bei Unterschreitung des eingestellten Wertes gibt die Anzeige Alarm. 
Messgeber Tiefe:   Gebertiefe unter der Wasserlinie. Wird zur Gesamttiefe addiert.
Wind Anzeige: 
Zeige Wind Daten:   Ein/Aus.  
Arrow Color:   Wähle die Farbe des Windpfeiles, der Richtung und Stärke angibt. 0-1 kt 

ohne Anzeige, 1-8 kt dünn, 8-15 kt 2 Pixel groß, 15-22 kt 3 Pixel groß, >22 kt 
ist ein 4 Pixel dicker Windpfeil.

Kompass Anzeige: 
Zeigt die NMEA Daten eines Elektronischen Kompasses.
Log Daten: 
Gebraucht GPS für Log und Trip Kalkulation. 
Zeige Log und Trip.   Falls gewählt, werden diese Daten im GPS Feld aufaddiert. 
Schalte Log AUS.   Falls die Geschwindigkeit unter den eingestellten Wert sinkt werden Log und 

Tripdaten nicht aktualisiert.

AIS: 
Show AIS Targets: Schaltet die AIS Darstellung An/Aus.
Show AIS Panel: Zeigt die AIS Anzeige in der 
   Navigationsleiste (im Automaticmodus = keine  Darstellung) 
Show AIS Labels: Zeigt die AIS Signalgeber mit Namen auf 
   der Karte. 
CPA Max: Entfernungsgrenze für die CPA Warnung.
TCPA Max: Zeitbegrenzung als Anzeige für eine CPA 
    Warnung. Abgeschaltet beim Wert 0
Target Color: Farbe für AIS Signale.
Target Size: Signalgröße.

Beachte:  Tiefe, Wind, AIS und Kompass müssen NMEA kompatibel sein und über einen Multiplexer an den PC 
weitergegeben werden, sonst werden die Felder nicht angezeigt.
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Comm
NMEA Verbindung:
PC Port.   Com 1 - 256. Wird gleichzeitig für Senden und Empfangen genutzt.  
BPS:   Bit rate Einstellung. NMEA ist gewöhnlich 4800.
Beachte: SeaClear empfängt Daten von bis zu 3 Eingängen (com ports). NMEA Durchlauf (Pass-through) kann genutzt 
werden damit SeaClear Daten nur filtert (multiplexer). So kann z.B. ein USB GPS für die Position genutzt und über den 
Seriellen Anschluss der Autopilot angesteuert werden.

GPS Datum:
Muss auf das geodetic datum des GPS eingestellt sein – im Regelfall WGS 84. Wählen sie aus der 
Liste.
NMEA DR Update: 
Sollten die GPS-Daten ausfallen und NMEA-Daten für Geschwindigkeit und Elektro-Kompass 
vorliegen, werden diese in der DR Anzeige verarbeitet.  Diese Geloggten Daten werden für eine 
grobe Kalkulation von SeaClear verwendet bis wieder GPS Daten einen exakten Fix ermöglichen. 
NMEA Durchgang:
Daten die sofort weitergereicht werden. Diese Daten werden über die Funktion NMEA OUT EIN/AUS 
gesendet. Von SeaClear erstellte Daten dürfen nicht aufgeführt werden.
NMEA Ausgang:
Wenn die Route aktiviert ist und  “NMEA OUT ON” gewählt ist, werden die berechneten 
Routendaten übermittelt.
Datensätze:  Wählen Sie welche Daten an einen Autopilot, Radargerät oder weiter NMEA-

Geräte, abhängig von ihrem Input gesendet werden sollen. WPL + RTE wird 
dabei nur gesendet wenn aktiviert, alle anderen Meldungen werden im 
Zeitinterval der Auswahl gesendet. Der “Export NMEA” wird für Datei > Route 
der Datei >Wegepunkt genutzt, unabhängig vom NMEA Output Schalter.

Übertragungsart:   Wegepunkt-Namen werden vor der Übertragung gefiltert. “Upper Case” sollte 
mit den meisten Geräten funktionieren, die eine NMEA Input Datensatz 
akzeptieren. “+Lower Case” erlaubt ASCII Zeichen (>128). “As Is” übermittelt 
den Text als Windows ANSI standard 8 bit. “Numeric” sendet nur Wegpunkt 
numeric id und sollte selbst mit älteren Geräten die NMEA input unterstützen, 
funktionieren. Diese Einstellungen beeinflusst, was von einer Route- oder 
Wegepunk Datei mit Export an NMEA übermittelt und wie sie als WP+ oder 
G7ToWin gespeichert wird. "Nexus" übermittelt Daten in das Silva Nexus und 
NX2 Format.

Update Intervall.   Intervallzeit - wie oft die NMEA Daten übermittelt werden.
XTE Ampl. Faktor.   Der XTE-Versatz dient 

dem Autopiloten um 
einen genaueren Kurs 
halten zu können und 
dem “Schlangenkurs” 
vorzubeugen. Dabei 
100% 1:11.

NMEA Id.   NMEA Talker 
Identification, immer 2 
Buchstaben. Normal ist 
“EC” oder "GP". 

Speichere WP Id:   Ein/Aus. Falls Ein, 
gesperrte Wpt-Namen 
werden für alle 
Routenteilstücke 
genutzt. Nötig evtl. für 
einige Geräte die sonst 
eine Bestätigung 
erfordern. 
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Andere
Alarmton An:
Gebraucht die gewählte Alarmton Sound Datei der win.ini Datei.
Startup:
Aktualisiere PC ...   Nutzt die sehr exakte GPS Zeit um die PC Systemzeit  zu aktualisieren.  
Lade letzte Wpt…   Lädt die zuletzt verwendete Wegepunkt Datei (auch ungespeicherte) 
Lade letzte Route:   Lädt die zuletzt verwendete Route (auch eine ungespeicherte).

Wegepunkte:
Normale Farbe:   Farbe der Normalanzeige von Wegepunkten. 
Ausgewählte Farbe:   Farbe für Hervorgehobene Anzeige von Wegepunkten. 
Größe:   Markergröße. 
Zeige Wegepunkt Info:  Zeigt den Wegepunktnamen auf der Karte.
Nacht-Abdunkelungs-Modus. 
Wählt die Abdunkelung und was.  
Filter 2-4:   Wählt die Abdunkelung in % für jeden Filter.  In % von -95 bis 95, wobei 0 

keine und 95 der dunkelste Filter ist. Ein Negativ % Filter wird vor dem 
abdunkeln invertiert. 

Gesamter Bildschirm:   Verdunkelt nicht nur die Karten sondern den ganzen Bildschirm.
Karten-Rand-Linie. 
Farbe: Wählt die Farbe der Karten –rand- Linie. 
Max. Maßstab: Welche Karte soll angezeigt werden? Bei 20 werden Karten mit dem Maßstab 

1 –20 * der geladenen Karte angezeigt.
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Installieren von Karten
MapCal
Um neue Karten zu installieren oder existierende nachzukalibrieren, nutzt man MapCal_2.exe. Eine 
gerastete Bitmap Bilddatei und Kalibrationswerte sind nötig um eine Geografische Adresse 
darzustellen. Mindestens 2 Kalibrationspunkte sind dazu nötig. Um die Kalibration zu prüfen kann 
ein Gitternetz darüber gelegt werden. Ein neu definierter Kartenrand rahmt den nutzbaren 
Kartenbereich für eine Automatische Auswahl. Beides, Gitternetz und Rahmen nutzen den 
eingestellten Maßstab. 
Bild- Dateien (PNG, BMP…) benötigen eine eigene Kalibrationsdatei, während bei  WCI diese direkt 
in der Bild-Datei abgelegt sind. BSB/KAP und GEO/NOS Dateien sind vorkalibriert und können nicht 
mit MapCal geändert werden. Es ist aber möglich sie zu öffnen und die Koordinaten zu prüfen. 
Frühere Versionen von SeaClear nutzten eine andere Art von Kalibration, diese kann aber in das 
neue Format umgeschrieben werden. 
OziExplorer *.map Dateien können mit Bild und Kalibrationsdaten importiert werden. Beachte, das 
*.map Dateien keine visuellen Referenzpunkte hat und der Maßstab vom Pixelwert abhängig ist. Nur 
Vor-Kalibrierte *.map Dateien können importiert werden. 
Win GPS Kartenkalibration  *.chi Datei kann importiert werden. Liegt die Karte als BMP-Format vor, 
kann sie direkt von SeaClear gelesen werden. Eine Kalibrierungsdatei für alle Karten wird im selben 
Verzeichnis wie die bestehende *chi-Datei angelegt. Nach einem Import aller Karten und der 
Kalibrationsdatei können diese direkt verwendet werden.
GMB Dateien können umgeschrieben werden. Eine bestehende IN8-Datei wird in das neue WCI-
Format übernommen. Der Maßstab muss dabei manuell eingegeben werden. Falls aber alle 
Kartendateien in einem Verzeichnis liegen ist dies nur bei der ersten Karte nötig. Die weiteren 
Karten werden angepasst.  
MapCal kann viele Bildformate in WCI umwandeln um von SeaClear genutzt werden zu können. 
BMP, PNG, GIF, TIF, JPG, PCX und viele weitere können umgeschrieben werden. SeaClear kann 
nur BMP, PNG und GIF Dateien direkt einlesen, andere Formate müssen zuerst als WCI-Format 
umgeschrieben werden. 
WCI Dateien können als BMP (mit den Kalibrationsdaten) und zurück, umgewandelt werden. Damit 
kann eine Nachbearbeitung (z.B. in Paintbrush) durchgeführt werden. 
Um ein Automatisches Laden der Karten zu ermöglichen, nutzt die Datenbank Kartenlayout und 
Maßstab. Diese Datenbank wird von MapCal erstellt und muss up(ge)dated werden, falls eine 
existierende oder neue Karte nach-/kalibriert wird. Welches Karton-Datum verwendet wurde, wird 
ebenso geprüft (z.B. Berechnung nach WGS 84).

Karten installieren
Folgende Schritte sind nötig um eine Karte für SeaClear zu installieren (um BSB Karten zu 
installieren siehe weiter unten).

1: Momentan unterstützt SeaClear Fixed grid, Mercator, Transverse Mercator, Polyconic, Lambert 
Conformal Conic und Sinusoidal projizierte Karten. Projektionen basierend auf Transverse 
Mercator, wie UTM und Gauss, werden ebenfalls unterstützt. Die meisten Projektionen sind bei 
kleineren Karten recht brauchbar und genauer als für die Navigation benötigt. Fast alle Flachbrett-
scanner können benutzt werden und sollten die Karte farbig darstellen. Scannen sie eine 
Papierkarte oder “frieren” sie eine Geladene vom Bildschirm. Bestimmt sind am Anfang einige Test 
nötig um die Genaue Ausrichtung, die Bildbrillanz und den Kontrast einzustellen. Die Datei sollte 
als unkomprimierte BMP oder komprimierte PNG (Palette Format mit max. 256 Farben) 
gespeichert werden. BMP Dateien können nachbearbeitet werden, lassen aber keinen 
Nachtmodus in SeaClear zu. Falls sie also die Datei nicht ins WCI Format übernehmen wollen, 
sollten sie diese als PNG oder GIF speichern. Natürlich können mehrere, leicht überlappende 
eingescannte Bilder zusammen-“geklebt” werden. Eine Auflösung von 100 bis 250 DPI wird 
vorgeschlagen. Bei einer Größe von 2000 * 2000 Pixel benötigen sie also alleine 4 MB 
Arbeitsspeicher zum Laden, während der Festplattenspeicher vom Datei-Format abhängt. 
Speichern sie die gesamte Karte unter ..\SeaClear\Charts. 
Wie einfach dies mit bereits digitalisierten Amtl. Seekarten kostenlos funktioniert verrät der 
CoAutor – siehe: http://www.skipper-udo.de/SeaNavCD.html 
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2. Starten sie MapCal_2.EXE. Möchten sie das WCI Format nutzen, klicken sie Tools->Convert-> 
Single file to WCI um die Karte als WCI Format umzuschreiben.
3: Öffnen sie die Orginal- oder WCI Datei  mit  "File->Open Image" im Verzeichnis 
..\SeaClear\Charts".
4: Sollte sich das Karteninformationsfeld nicht automatisch öffnen, rufen sie es mit "Edit->Chart 
Information" auf, um einen Kartennamen (der nicht dem Dateinamen entsprechen muss), Maßstab, 
Projection und Karten datum, einzutragen. Weitere Info-Angaben sind optional. Sollte Lat Shift 
oder Long Shift genutzt werden, wird die Chart Datum Einstellung überschrieben. Entnehmen sie 
älteren Papierkarten die Korrekturhinweise inwieweit für den GPS Gebrauch die Karte versetzt 
werden soll. Neues Kartendatum ist dann WGS 84. Latitude 0 ist Null für die meisten Karten, 
wärend Longitude 0, das “central meridian” der Transverse Mercator, Polyconic, Lambert and 
Sinusoidal Projection ist und ein Wert nahe dem Karten-Lon eingetragen werden soll. Falls nicht 
bekannt, lassen sie ihn auf 0 und MapCal wählt diesen für sie. Falls die Lambert Projection 
gewählt wird, sollte Nord oder Süd eingestellt werden. Ist dies nicht bekannt, belassen sie die 0 
und MapCal wählt die Normaleinstellung. Priority (Vorrang) wird für das auto-loading genutzt, 
wobei 1 der höchsten Vorrangstufe entspricht. Eine Priorität von 10 entspricht  dem halben 
Maßstab, somit  ist ein 1/25000 Maßstab mit Priorität 10 gleich einer Karte mit Maßstab 1/50000 
der Priorität 1. Benötigen sie keinen “auto-load”, die Karten sollen aber in der Liste auftauchen, 
benutzen sie eine höhere Prioritätsnummer. 
5: Setzen sie mindestens 2 Kalibrierungspunkte an bekannten Positionen der Karte, soweit 
möglich in gegenüberliegenden Ecken und tragen die Lat/Lon Daten ein. Ausgenommen für Fixed 
und Mercator Projektionen, benötigen sie mindestens 3 Punkte.  Dazu setzten sie den Cursor auf 
die gewünschte Position und klicken Rechts. Wählen sie “add new calibration point”. Mit einem 
Linksklick und halten können sie diesen Marker verschieben oder nutzen die 4 Pfeile für eine 
Nachjustierung. Tragen sie nun die korrekten Lat/Long Daten ein. Mit Linksklick und halten in der 
Karte oder dem Rollbalken verschieben sie die Karte zum nächsten Punkt. Wiederholen sie die 
Prozedur Rechtsklick “add new…” und tragen die dazugehörigen Daten ein. Bei geklebten Karten 
empfiehlt es sich mehrere Punkte zu vergeben. Die Reihenfolge ist dabei unwichtig.
6: Im Rollmenü Grid (Gitter) wählen sie nun “Normal Grid” und bestätigen dies mit "Activate 
Changes". Um die Farbe des Gitters zu ändern, klicken sie auf  das momentan pinkfarbene 
Kästchen. Stimmt das Gitter mit der Originalkarte überein, sind sie fast fertig. Falls aber das Gitter 
nicht optimal übereinstimmt, wählen sie über das Rollmenü “Callibration Point” einen Punkt aus 
und verschieben ihn wie gewohnt oder weisen sie weitere zu. Werden Punkte nur verschoben 
berechnet MapCal bereits die neuen Lat/Lon Werte, die mit "Activate Changes" sichtbar gemacht 
werden. Die Kalibration muss abgeschlossen sein, bevor Schritt 7, der Kartenrahmen als 
Weltkoordinaten gespeichert wird.
7: Klicken sie am linken Bildschirmrand auf den Reiter “Border” um einen Kartenrand einzustellen. 
Randpunkte werden genauso wie Kalibrierungspunkte eingegeben. Oder klicken sie nur "Set 
Border to Image" um einen Rahmen von 5 Punkten zu erhalten. Dies würde aber auch automatisch 
erfolgen, falls sie nicht einen abweichenden Rahmen eingeben.
8: Sichern sie die Kalibration mit File->Save Calibration.

Das sollte alles sein was sie machen müssen. Nach dem Kalibrieren neuer Karten, übernehmen 
von alten SeaClear 1 Kalibrationen, hinzufügen von vorkalibrierten Karten wie BSB/KAP oder der 
Änderung eines Kartenpfades muss die Auto-load Liste erstellt oder updated werden. Dazu klicken 
sie Tools > Autoload List > update (evtl. auch bei einigen Formaten recreate). Die Auto-load Liste ist 
nötig um in SeaClear die richtige Karte automatisch laden zu können.

21



SeaClear MMV

MapCal Referenzen
Beachte: Da es für MapCal keine Sprachübersetzung gibt sind nur die Funktionen übersetzt

File Menu.
⇒ Open Image: Öffnet fast jede Bilddatei, Kalkulationsdaten werden, falls vorhanden automatisch geladen.

⇒ Open From List: Wähle eine Karte der Auto-load Liste. (Falls bereits erstellt)  

⇒ Save Calibration: Sichert Kalibrationseinstellungen (Falls erstellt).

Edit menu:
⇒ Chart Information: Öffnet das Karten Info Fenster. Tragen sie hier Maßstab, Projection und Karten Datum 
ein. Der Rest ist optional. Siehe dazu Schritt 4. Das Fenster wird beim Laden von neuen Karten automatisch 
geöffnet. Sie können hier aber auch nachträglich Änderungen vornehmen und mit save cal. – speichern. 

Tools menu:
Das Convert Menu ist für das Umschreiben in andere Formate.

⇒ Convert ->Current to WCI: Konvertiert die geladene Karte und der Kalibration in WCI Format. 

⇒ Convert ->Current WCI to BMP: Konvertiert die geladene WCI Karte und der Kalibration in BMP Format.

⇒ Convert->Single file to WCI: Konvertiert Einzelbilddateien als WCI. Die meisten Bildformate können als WCI-
Format konvertiert werden, auch viele Formate die nicht  von MapCal oder SeaClear direkt gelesen werden. Sie 
sind evtl. nicht kalibriert.
⇒ Convert->Images in Dir to WCI: Konvertiert alle Bilddateien eines Verzeichnisses. Die Karten sind evtl. nicht 
kalibriert und müssten einzeln im WCI Format nachkalibriert werden. 
⇒ Convert->MAP in Dir to WCI: Konvertiert alle OziExplorer MAP und Bild-dateien als kalibrierte WCI Datei. 

Import Cal menu dient dem Import von Kalibrationsdaten in ein hier genutztes Format.
⇒ Import Cal->Old SeaClear Calibration: Importiert alle gefundenen Kalibrationen der alten SeaClear Version. 
Der Pfad muss angegeben sein und die seachart.dir Datei in diese verschoben werden. Dabei aber werden bei 
Karten mit demselben Karten Dateinamen, die neue Kalibration überschrieben.
⇒ Import Cal->CHI Calibrations: Importiert alle Kalibrationsdaten der  WinGPS .chi Dateien.

Mit der Autoload List menu wird die SCAINDEX.BIN Datei erneuert.
⇒ Autoload List->Scan for New Charts: Sucht nach neuen Karten im Karten-Verzeichnispfad. Autoload List-
>Update: Sucht nach Kalibrations-Änderungen und neuen Karten im Kartenverzeichnis. Karten-daten die nicht 
gefunden werden verbleiben in der Liste (z.B. sie nutzen ein CD Laufwerk haben aber keine CD eingelegt). 
⇒ Autoload List->Recreate: Löscht die alte SCAINDEX.BIN und schreibt eine Neue und sucht dabei in allen 
angegebenen Kartenpfaden. Nur tatsächlich gefundene Karten sind in dieser neuen Liste.

Maintenance.
⇒ Remove Unused  Calibrations: Löscht unbenötigte Kalibrierungen falls Karten ohne eingearbeitete 
Kalibrierung aus dem Verzeichnis entfernt wurden. 

Mit Set Directories können alle von MapCal und SeaClear genutzten Kartenpfade eingestellt 
werden.

⇒ Set Directories: Stellt den benötigten Pfad ein und erneuert die SEACLEAR_2.INI Datei. 

<< 
Klappt das Eingabe-Fenster nach links um das Kartenfenster zu maximieren. Um es erneut 
anzuzeigen ziehen sie nur die Mouse wieder an den rechten Rand.
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Installieren von Vor-Kalibrierten Karten
SeaClear ist vorbereitet um normale BSB/KAP und GEO/NOS Dateien sofort zu nutzen. Um sie aber 
in der Kartenliste aufzuführen und zum automatischen Laden, müssen sie eingetragen werden. 
Nichteingetragene aber kalibrierte Karten können in SeaClear mit “File->Chart->Not Listed geöffnet 
werden.

Installieren von BSB Karten
Das BSB/KAP Dateiformat ist lizenziert von MapTech. Die BSB/KAP Version 1 – 3 wird unterstützt. 
Projektionen basierend auf Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic 
und Sinusoidal sind ständig verwendbar.  
Karten für die meisten Gebiete der Erde stehen von Maptech, NDI und anderen Anbietern zur 
Verfügung. Das aktuelle Kartenbild ist die KAP Datei, während die BSB Datei nur Kalibrierungs- 
Daten enthält. Da SeaClear seine eigene Datenbank nutzt sind BSB Daten nicht nötig.  
Bevor die BSB/KAP Karten von SeaClear genutzt werden, sollten sie registriert sein:

Starten sie MapCal und stelle sie sicher, dass alle KAP Dateien im Karten-Verzeichnis abgelegt 
sind.  Vom Hauptmenü wähle sie nun “Tools-> Autoload list-> Scan for New Charts”. Die KAP 
Dateien werden nun nach Name, Abdeckung und anderen Daten durchsucht und in der SeaClear 
autoload database aufgelistet. 

Installieren von GEO/NOS Karten
Nur Projektionen basierend auf Mercator, Transversal Mercator, Polyconic, Lambert Conformal 
Conic und Sinusoidal werden ständig unterstützt.  
Die aktuelle Karte ist eine NOS Datei, während die GEO Datei nur Kalibrationsdaten und 
Allgemeines beinhaltet. Beide, die GEO und die NOS Datei sind nötig und müssen im selben 
Verzeichnis abgelegt sein.  Bevor die GEO/NOS Karten von SeaClear genutzt werden, sollten sie 
registriert sein:

Starte MapCal und stelle sie sicher, dass alle GEO und NOS  Dateien im Karten-Verzeichnis 
abgelegt sind.  
Vom Hauptmenü wähle sie nun “Tools-> Autoload list-> Scan for New Charts”. Die GEO Dateien 
werden nun nach Name, Abdeckung und anderen Daten durchsucht und in der SeaClear autoload 
database aufgelistet. 

Installieren von WCI Karten
Starte sie MapCal und stellen sie sicher, dass alle WCI Dateien korrekt kalibriert und im 
Kartenverzeichnis liegen.   
Vom Hauptmenu wählen sie “Tools->Autoload list-> Scan for New Charts”. Die WCI Dateien 
werden nach Name, Eck- und anderen Daten abgesucht und in SeaClear aufgelistet. 

Die WCI, KAP und NOS Dateien sind disk mapped, von einer CD herabgeladen ergibt sich daraus 
eine langsamere Verarbeitung, weshalb eine Speicherung auf der Festplatte empfohlen wird. 
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Hinweise

SeaClear Installation
Installation auf die Festplatte
Das Automatisierte Installationsprogramm legt standardmäßig SeaClear auf der Festplatte ein neues 
Verzeichnis in C:\Programme mit Unterverzeichnissen für "CHARTS", "ROUTES", "TRACES" und 
"WAYPTS" an: 
<Base Dir>: 
SeaClear_2.Exe 
MapCal_2.Exe 
Datums2.Ini 
 <Base Dir>\Charts: 
   World.WCI 
   Med.WCI 
   USA.WCI 
   Sweden.WCI 
<Base Dir>\Routes: 
   (Laden und Speichern sie ihre Routen hier) 
<Base Dir>\Traces: 
   (Traks werden hier automatisch gespeichert) 
<Base Dir>\Waypts: 
   (Laden und Speichern sie Wegepunkt hier) 
In Zukunft werden die, SCAINDEX.BIN und SEACLEAR_2.INI  automatisch erstellt.

Start der SeaClear Software von einer CD
SeaClear kann von einer CD geladen werden, aber, da CD-Laufwerke nur “Leselaufwerke” sind 
kann nichts gespeichert werd. Die "SEACLEAR_2.INI" Datei muss im selben Verzeichnis wie die 
SeaClear_2.exe liegen, deshalb wird empfohlen diese auf der Festplatte abzulegen.  Disk mapped 
Karten (WCI/KAP) werden langsamer verarbeitet, wenn sie von einer CD gelesen werden.  
Wie auch immer, da Karten einen großen Speicherplatz benötigen kann SeaClear von der Festplatte 
und die Karten aus dem CD Laufwerk  geladen werden. 
Mit den neuen Speichermedien (MMC, SD…) oder USB Sticks kann SeaClear auf jedem Win 98 SE 
bis  Win7 basierenden Betriebssystem, direkt von diesem Speicher mit den dazu nötigen Karten 
gestartet werden. SeaClear schreibt keine Dateien nach Windows und läuft nachdem sie das ganze 
Verzeichnis auf diesen Speicher geladen haben auf jedem Windows Rechner. Evtl. müssen sie aber 
mit MapCal >Tools >Set Directories den Laufwerksbuchstaben ändern, da dieser von PC zu PC 
anders vergeben wird.

Gebrauch von mehreren Karten Verzeichnissen
Da CD-Laufwerke oft sehr langsam arbeiten, können oft verwendete Karten auf der Festplatte 
abgelegt werden und selten genutzte verbleiben auf der CD. Öffnen sie MapCal >Tools >Set 
Directories und geben (z.B.) folgende Zeile ein: 
"Chart Dir=C:\SEACLEAR\CHARTS\;D:SEACLEAR\CHARTS\;D:\MOREMAPS\" (sollte SeaClear in 
einem Unterverzeichnis liegen müssen sie dieses mit angeben. Beispiel: 
c:\Programme\SeaClear\Charts\;D:SeaClear\Charts….)
Alle Karten die nun in den Verzeichnissen  C:\SEACLEAR\CHARTS, D:\ SEACLEAR\CHARTS und 
D:\MOREMAPS liegen werden im Kartenfenster angezeigt.  
Karten, die in diesem Pfad nicht aufgeführt wurden, können ebenfalls angezeigt werden, wenn sie 
mit MapCal kalibriert und installiert wurden.
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De-Installierung
Alle Dateien die installiert und erstellt wurden liegen im Verzeichnis SeaClear. Es wurden keine 
weiteren Dateien außerhalb dieses Verzeichnisses erstellt. Um SeaClear zu entfernen, löschen sie 
einfach das ganze Verzeichnis und die erstellten Shortcuts. 
Bei der Vollinstallationsversion benutzen sie  Windows Start > Systemsteuerung > Software und 
wählen den Schalter Ändern/Entfernen an. Bestätigen sie das Deinstallieren mit Ja. 

Technische Informationen
Der Computer
Ein PC mit Windows Win7/Vista/XP/2000/NT oder 95/98/ME. Einige Einschränkungen in Windows 
95/98/ME lassen Win7/Vista/XP/2000/NT die besser Wahl erscheinen, vermeidet kleinere Probleme 
und erlaubt darüber hinaus weit größere Karten zu laden. 
Minimum 800 * 600 Bildschirm. 1024 * 768 wird bevorzugt um alle Informationen der 
Navigationsleiste anzeigen zu können. 
Mouse. 
1 freier Serieller oder USB- Port für das GPS. 
Pentium+ oder vergleichbarer Prozessor. 
Min 32 Mb RAM memory. 64 Mb (abhängig vom OS), wird erwartet und beschleunigt das 
Kartenlesen. 
PNG Dateien sind langsamer zu lesen und benötigen mehr Arbeitsspeicher, Pentium und 64 Mb 
wird empfohlen.  
10 - ???? Mb freien Speicherplatz auf der Festplatte. (4 Mb für SeaClear und  ? Mb / Karten). Jede 
Karte ist in der Regel eine recht große Bitmap. Falls Ihr Windows für mehr als 256 Farben eingestellt 
ist, benötig der PC zu Erzeugen der großen Bitmaps viel Arbeitsspeicher und verlangsamt das 
System. Es wird deshalb empfohlen Windows auf max. 256 Farben einzustellen, selbst wenn das 
Video Subsystem mehr erlaubt. Dies ist  teilweise für W95/98/ME wichtig und wirkt sich auch auf 
PNG-Dateien aus, da diese einmal entpackt  einen weit größeren Arbeitsspeicher benötigen als 
gepackte (Format-verdichtete) auf der Festplatte. Bei disk mapped Karten (WCI & KAP), wird nur der 
sichtbare Teil der Karte geladen und hat damit weit weniger Zusammenhang mit dem Windows 
Setup. 
Alle Versionen von Windows haben eine 32K Begrenzung auf Bilddateien, womit die maximale 
Kartengröße auf 32K * 32K begrenzt ist und auch die maximale Zoomgröße reduziert. So können 
nur Karten mit weniger als 8K * 8K bis auf 400% vergrößert werden. 
Ausdrucke von großen Karten sind oft nur mit Windows NT/2000 oder besser möglich. 

Anschluß des GPS und anderer NMEA talkers
Das GPS muss einen NMEA OUT Ausgang haben (Zeichensatz NMEA 0183 RMC, RMA oder 
GGA / GLL & VTG). Falls das GPS auf verschiedene NMEA 0183 Versionen eingestellt werden 
kann, wählen sie NMEA 2.0. Ältere Versionen von 0183 arbeiten evtl., sind aber nicht besonders 
geprüft. Schlagen sie in ihrem GPS-Handbuch nach, wie es an einen PC angeschlossen werden 
kann. Da NMEA für das “serial port data setup” spezifiziert ist (mit Ausnahme des korrekten PC-
Com-ports), sind weitere Einstellungen normalerweise nicht nötig. Das GPS muss nur mit Rx und 
Masse an den PC angeschlossen werden (Ausnahme sie möchten Wp-Dateien and das GPS 
zurückschicken = Tx). Ein 9-pin-Anschluß (RS 232 oder Com1 Port), häufig bei älteren Laptops 
genutzt, ist folgendermaßen belegt , Pin 2=Rx, 3=Tx, 5=Masse. Bei den meisten Marktüblichen GPS 
Geräten wie Magellan, Garmin und MLR funktioniert dies problemlos.
Wird eine GPS Mouse via USB installiert wird ein ComPort ( i.d. Regel Com3 bis 12) simuliert. Dies 
wird bei der Installation der GPS Mouse angezeigt. Stellen sie den korrekten Port unter SeaClear 
Bearbeiten > Einstellungen > Com über den dortigen Rollbalken ein. Die Baud-Geschwindigkeit 
bleibt dabei unverändert auf  BPS 4600.
NMEA RMC, GGA, GLL, DBT, VTG, VWR, VWT, MWV, MWD, VHW, HDM, HDG, HDT, ZDA, RMA, 
MTW,  DTM, VDM und DPT Datensätze sind entschlüsselt.
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Anschluss eines NMEA Empfängers
Ein NMEA Empfänger, wie z.B. ein Autopilot  muss folgende NMEA Zeichensätze interpretieren 
können.  APA, APB, RMB, BOD, BWC, WPL und RTE. Schlagen sie in ihrer Betriebsanleitung nach, 
wie dieses Gerät an einen PC angeschlossen wird. Da NMEA für das “serial port data setup” 
spezifiziert ist, muss keine Einstellung verändert werden. Der PC Ausgangs-port ist derselbe den 
das GPS als Eingang nutzt. Der Empfänger ist an Tx und Masse mit dem PC verbunden. Da beides, 
die Richtung und der maximale XTE-Fehler an den Autopiloten übermittelt werden, kann dieser recht 
genau die vorgegebene Routenlinie halten. Die empfangenen NMEA-Meldungen werden über den 
Ausgang weitergeleitet.

Kalkulation und Genauigkeit
Richtung und Entfernung werden als “rumbline” kalkuliert. Alle Kalkulationen werden mit doppelter 
Präzision berechnet um Mathematische Fehler zu eliminieren. Bei größeren Distanzen ist die 
“rumpline”-Berechnung etwas ungenauer wie in der “arcepelago” (Großkreisberechnung) Navigation. 
SeaClear kann nicht mit Karten arbeiten, welche die Datumslinie überspannen (180 E/W)

WCI Datei Format
Das neu geschaffene Dateiformat WCI (World Calibrated Image) wird unterstützt. Es erlaubt “disk 
mapping” (s. dort),  beinhaltet Welt Kalibration Daten und kann aus ihren bestehenden Karten-
Dateien erstellt werden. Es komprimiert recht gut und erlaubt eine Nachkalibrierung. WCI ist ein 
“palette Format” das bis zu 256 Farben und eine maximal Größe von 32767 * 32767 Pixels und 1Gb 
erlaubt. MapCal kann zur Erstellung von WCI Files genutzt werden. Nur “palette”-Bilder können 
umgerechnet werden. Dieses Format arbeitet ausgezeichnet mit großen Karten mit geringerer 
Farbtiefe. Um beste Resultat damit zu erzielen sollte die Karte weniger als 64 Farben und große 
einfarbige Flächen haben. 

Disk Mapping
Disk mapping wird von WCI, BSB/KAP und GEO/NOS Dateien genutzt. Es erlaubt die Arbeit mit 
riesigen Bitmap-dateien. Dateien im nicht verdichteten Zustand von über 150 MB wurden getestet 
und arbeiten sogar mit Systemen mit begrenztem Memory. Falls möglich sollten diese Dateien nicht 
direkt vom CD-Laufwerk geladen werden, da sie erneut beim jedem Bildschirm-Update eingelesen 
werden. Beim Zoomen macht sich ein geringer Zeitverzug bemerkbar, da die Bildschirmdarstellung 
mit dem Originalbild verglichen und ständig nachgerechnet wird. 

Karten Datei Formate
SeaClear ist entwickelt um den vollen Gebrauch von “disk-mapped” Formaten machen zu können. 
Aber auch PNG oder BMP Karten können weiterhin genutzt werden. Da Karten Kalibrationsdaten 
benötigen, werden diese in einer separaten Datei im selben Verzeichnis gespeichert, während KAP 
und WCI eingebundene Kalibrationsdaten in der jeweiligen Datei haben. BMP erstellt sehr große 
Dateien und kann nicht für den Nachtmodus abgedunkelt werden. PNG verdichtet recht gut. 
Kalibrierte PNG und BMP Bilddateien können in WCI Formate umgewandelt werden. MapCal kann 
auch viele weitere Bildformate in WCI-Formate, zum Gebrauch von SeaClear umwandeln.

Magnetische Missweisung 
SeaClear kalkuliert automatisch die Missweisung für das aktuelle Seegebiet. Die Kalkulation basiert 
auf die meisten zugänglichen Daten, um das beste Resultat zu erzielen. Magnetische Anomalien 
sind nicht mit einbezogen. Um eine Programminterne Berechnung abzuschalten und die vom GPS 
gelieferte Missweisung zu nutzen,  sehen sie bitte unter SeaClear_2.INI Datei Einstellungen nach.
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Gebrauch von G7ToWin für den Datenaustausch mit einem GPS
SeaClear kann mit der Fremdsoftware g7toWin arbeiten. 
Beachte: Einige GPS Geräte benötigen eine NMEA-Protokolumstellung um mit G7ToWin Software 
Daten austauschen zu können. Die G7ToWin Version A.00.140 wurde getestet, neuere Versionen 
sollten ebenfalls funktionieren. 
1: Speichern sie eine Kopie von G7ToWin.exe in dasselbe Verzeichnis in dem die SeaClear_2.exe 
liegt.
2: Starten sie G7ToWin und richten sie die Übertragungseinstellungen zum GPS ein. Prüfen sie die 
Funktion und speichern sie die funktionierende Einstellung. Beenden sie G7To Win. 
3: Starten sie SeaClear. Das GPS Menü ist nun in SeaClear eingebunden. Wegepunkt und Routen 
können von und an das GPS, Tracks können vom GPS an SeaClear geschickt werden. 
Sollen Daten von SeaClear an das GPS geschickt werden, legt SeaClear eine Datei im *.g7t Format 
an. Mit einem aktivierten G7ToWin werden diese Daten an das GPS übermittelt. 
Um Daten eines GPS zu erhalten wird zuerst die Software G7ToWin aktiviert. Diese legt eine Datei 
im *.g7t  Format an die von SeaClear importiert werden kann Datei > Wegepunkte > Import.   Für 
den Download von Tracks (Verlaufsspur) eines GPS werden die letzten Trackpunkte als Datei 
abgelegt. Diese Datei sieht etwas so aus: "20060603-g7t (1).trc". Die vorübergehend angelegte 
Datei (temporary g7t) ist immer "$$g7to$$.g7t" und liegt im SeaClear Verzeichnis. Jede Mitteilung 
während das GPS Daten übermittelt, wie "Error More then 30 points - Rest are skipped" wird von 
G7ToWin hergestellt. SeaClear erhält keine Rückmeldung auf Fehler. Falls während des Empfangs 
nichts dargestellt wird ist ein Fehler aufgetreten. Alle in SeaClear dargestellten Wegepunkte (ob dort 
gesetzt oder vom GPS erhaltene) beziehen sich auf das WGS-84 datum. Stellen sie also sicher, 
dass im GPS, G7ToWin und dem GPS Setup WGS84 eingestellt ist.  G7ToWin DDD, DMM und 
DMS Wegpunkt-Format wird beim Import unterstützt. Alle Exportierten Daten sind im  DMM Format.
"Ziel Fähigkeit " (ob und wie das GPS Daten verarbeiten kann) werden im SeaClear Setup 
eingestellt. Stellen sie sicher, dass die Einstellungen mit ihrem GPS übereinstimmen. 

G7ToWin und Waypoint+ Datei Unterstützung
G7ToWin und Waypoint+ text Dateien werden für Import und Export unterstützt. Die Dateiendung 
gibt Auskunft über den genutzten Dateityp. Dateien von G7ToWin müssen eine *g7t Endung haben. 
Waypoint+ files sind im plain-text Format und haben eine *.txt Endung (die jeder Editor lesen und 
erstellen kann).

Nacht (Abdunkelungs-) Mode
SeaClear kann die Abdunkelung der Karte, falls diese im PNG, WCI oder KAP Dateiformat 
gespeichert ist, vornehmen.  Bei PNG Dateien  wird dies beim Laden der Datei vorgenommen und 

ändert es bevor die Karte dargestellt wird. 
Bei WCI und KAP wird die geladene 
Farbpalette geändert, somit ist ein erneutes 
Laden nicht notwendig.  
Vier Modi können im System Menü gewählt 
werden. Normal, Dämmerung, Dunkelheit 
und Nacht. 
Der Normalmodus unterliegt keiner 
Änderung. Die anderen drei 
Abdunkelungen können im Einstellungs- 
Setup Prozentual von 0-95 eingestellt 
werden, wobei der Wert 0 keine Änderung 
ist. Eine Negative Prozentzahl kehrt die 
Farben vor dem Abdunkeln um.  
Die Windows Oberfläche kann dabei mit 
einbezogen werden und wird über 
Einstellungen aktiviert.
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Sprache
Wählen sie eine Sprache 
Über Tools > Properties > Display > Language > … können sie aus dem geöffneten Fenster eine 
neue Sprache (z.B. German_2.LNG) wählen. Der meiste Text (mit Ausnahmen von MapCal) ist 
übersetzt und die Sprachauswahl wird gespeichert.

Erstellen einer Sprachdatei
1: Öffnen sie die ENGLISH_2.LNG Datei mit einem Texteditor (z.B. Notepad) und speichern diese 
als erstes unter einem neuen Namen (z.B. meine_sprache.LNG). 
2: Benutzen sie den Texteditor weiter.  Alle Textteile haben einen Schlüssel und eine Aussage: 
'_Form.XTELabel.Hint=Crosstrack Error'. Der Schlüssel steht links vom =Zeichen. Ändern sie diesen 
NIE. Die Textaussage steht rechts vom =Zeichen. Arbeiten sie sich durch die Datei und ändern sie 
dabei ihre Übersetzung ein. In Menüs, genau am &Zeichen wird ein shortcut erstellt (im Menue dann 
unterstrichen). Beginnt ein Text oder endet mit einem Leerzeichen, belassen sie dieses und 
beenden den Text. (Beispiel:  _Form.TX_MESSAGES.Lines.31=" is not saved! Save?). Beginnen sie 
keinen Text mit einer Zahl, - oder _. Die Kopfzeile "[Text_2]" muss die erste Zeile in der Datei 
bleiben.  Vergessen sie das Abspeichern nicht!
3: Wählen sie die neue Sprache wie oben angegeben.
4: Prüfen sie ob der Text in den zur Verfügung stehenden Platz passt! 
Bitte senden sie neue Sprachübersetzungen an:  06.seaclear@sping.com  damit diese weitergegeben 
werden können.
Beachte: Nur ANSI Zeichen können genutzt werden.
Beachte: Eine Vorlage Datei kann durch „save“ vor dem Dateinamen im Setup angehängt werden  (z.B. 
“save:C:\SC\LANG.LNG”). Statt eines Ladens dieser Datei wird diese nun (ohne das „save“) bereitgestellt. Alle gegenwärtigen 
Änderungen sind dabei enthalten. 

Geodetic Karten Datum
Das angeschlossene GPS sollte so eingestellt sein, dass es das WGS 1984 Datum übermittelt. Falls 
nicht, berichtigen sie im Einstellungen-Fenster das korrekte Datum. Die aktuelle Position wird dann 
auf die Basis WGS 84 übersetzt. Alle internen Berechnungen basieren auf diesem Datum. 
Falls Karten mit einem anderen Datum als WGS 84 gebraucht werden, muss die Karte normal 
kalibriert werden und mit dem Gitternetz übereinstimmen. Das im Infofenster angegebene 
GeoDatum wird dann verwendet um die korrekten Positionen für WGS 84 umzurechnen mit dem 
SeaClear arbeitet. Alle Positionen wie Schiff, Wegepunkt und Traks werden dann umgerechnet. 
Alle Karten des Geo-datums sind in der Datums2.INI Datei gespeichert. Nachkalibrierte Karten 
beziehen sich oft auf dasselbe Datum, verwenden sie also verschiedene Kartennamen. Während 
der Erstellung der Autoload Liste wird das Kartendatum geprüft und Nachkalibrierte Karten 
unterscheiden sich nur in verschiedenen Karten Datums. Die Unterscheidung wird in der 
[DatumsAliases]  Abteilung gespeichert

Karten Projektionen
SeaClear unterstützt Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic, 
Sinusoidal und Fixed Grid Projektionen. Viele Projektionen basieren auf  Transverse Mercator wie 
UTM, Gauss Krüger und viele andere werden ebenfalls unterstützt.  Die Projektion wird während der 
Installation ausgewählt. Falls der Zentral Meridan (Lon0) für die Transversal Projektion nicht bekannt 
ist, nutzen sie die Kartenmitte. Die Latitude des Orginales (Lat0) ist selten etwas anderes als 0. Für 
Lambert Projektionen müssen die Süd- und Nord Standart Parallelen bekannt sein. Wird die 
Projektion geändert muss die Kalibration überprüft werden.  
Weitere Variationen von Mercator, Transversal Mercator, Polyconic, Lambert Conformal Conic, 
Sinusoidal können der Datum2.INI Datei angehängt werden. 
Die [Projektions] Abteilung ist für Gebraucher-Projektionen vorbereitet.
Name=Base,Lat0,Lon0, LatS, LatN wobei der Name in der Rollliste angezeigt wird,  Base 1 für 
Mercator, 2 für Transverse Mercator, 3 für Lambert, 4 für Polyconic und 5 für Sinusoidal. Lat0 ist 
Latitude des Ordinales, Lon0 ist der Zentrale Meridian.  Falls benötigt,  wird die Rollliste in der base 
Projektion verändert. Lat0 und Lon0 werden mit den eingegebenen Werten ersetzt.
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Beachte: Das GPS System arbeitet mit WGS 84 geodetic datum und Umrechnungen sind nicht exakt.

AIS Signale
Wird ein AIS- Sende-/Empfänger oder Empfänger angeschlossen kann SeaClear diese, basierend 
auf einen möglichen NMEA VDM Binär Datensatz als Ziele darstellen. Es können keine Daten an 
das AIS Gerät weitergegeben werden. Alle AIS Ziele werden nach 4 Minuten automatisch gelöscht 
sobald kein Folgesignal empfangen wird.
AIS Sender werden mit dem HDT Datensatz (soweit vorliegend) dargestellt, sonst mit COG (Kurs 
über Grund). Sollte das ROT Signal empfangen werden, wird ein Wendekreis angezeigt und der 
Geschwindigkeitsradius beim Empfang von ROT Information angezeigt. Der Geschwindigkeitsradius 
hat denselben Vorhalt, wie der von ihnen Voreingestellte Speedmarker (Erreichbarer Punkt in * 
Sekunden). Die Fahrtrichtung des AIS Zieles wird bei entsprechendem Kartenmaßstab angezeigt

Im AIS Rollmenü werden alle AIS Sender dargestellt und bei jedem öffnen des Rollmenüs 
aktualisiert.  
AIS Sender. Bei einem Anklicken des Zieles wird die geplante Fahrrichtung falls möglich 
angezeigt, ansonst zeigt es den COG mit dem Wenderadius. Um weitere AIS Informationen 

des Zieles zu erhalten klicken sie Rechts auf das Ziel und wählen Tools->AIS Info:

UTC: 2005-09-12 23:20:44 UTC Zeit beim Erhalt des Datensatzes.
Name: SHIPNAME              Schiffsname
CallId: XXXX   Rufnummer
Dest: PORTNAME Zielhafen 
SOG: 13kn Geschwindigkeit über Grund
COG: 179,3° Kurs über Grund
HDT: ?° Geplante Fahrtrichtung, Magnetisch Wahr
ROT: 0°/min Kurswechselrate, Kursänderung in Grad pro Minute 
Lat: 12°34.567'N Position
Long: 054°32.109'E
Length: 25m Gesamtlänge des Schiffes.
Width: 6m Gesamtbreite des Schiffes.
Draft: 2m Tiefgang des Schiffes
MMSI #: 123456000 Schiffs MMSI Identifizierung
IMO #: ? Schiffs IMO Nummer
RNG 12.345NM Entfernung zum Ziel
BRG 234° Kurs zum Ziel
CPA 1.234NM CPA Kollisionsentfernung
TCPA 00:12.34 Zeit bis zur CPA
Felder mit unbekannten Daten werden mit einem Fragezeichen dargestellt. 
CPA und TCPA sind nur berechenbar wenn die Kollision CPA in den nächsten 24 Stunden möglich 
ist. 

Das ausgewählte AIS Signal wird mit einer Raute dargestellt! 
AIS Auswahlziel
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CPA Kollisionswarnung auf der Karte.
Wenn sich die CPA (Closest Point of Approach = Nahester Punkt der 
Annäherung) und TCPA (Time to CPA = Zeit zum CPA Ziel) der 
Überwachungszonen nähern wird eine Warnung in Form von 2 sich 
überschneidenden Ringen dargestellt. Der eine Kreis ist das eigene 
Schiff mit Berechnung COG (Kurs über Grund) und der Voreingestellten 
CPA Max (Zeit oder Entfernung). Der zweite Kreis ist das gegnerische 
AIS Signal (Schiff) mit COG Darstellungsrichtung, Schiffsname und (falls 
möglich) der Schiffslängenradius. Die CPA Warnung wird solange 
angezeigt wie TCPA (Kollisionszeitpunkt) zwischen 0 und TCPA Max 

liegen und CPA kleiner als CPA Max zuzüglich der Schiffslänge ist. Die CPA Daten werden dabei 
fortlaufend mit allen AIS Sendern, die dargestellt werden, neu berechnet. Sobald eine berechnete 
Warnsituation nicht mehr vorliegt, wird sie auch nicht mehr dargestellt. Um Warnsituationen nicht auf 
dem Bildschirm angezeigt zu bekommen muss der TCPA Max Wert auf  0 gestellt werden.  

SeaClear_2.INI File Settings
Die meisten Einstellungen werden intern von SeaClear vorgenommen. Es ist aber auch möglich 
diese Einstellungen mit einem Text Editor zu verändern. Diese Änderungen sollten nur von 
erfahrenen Computerbenutzern durchgeführt werden. Da eine Sprachmischung hier nur verwirrt 
verbleibt das Original.

Changable INI file settings (Veränderbare *.ini Dateieinstellungen)
[Program State] section
The section [Program State] is updated by SeaClear and should not be changed, except to reset log 
and time. SeaClear must not be running. 

To zero the log, delete the key:
Total Distance=XXXX

To zero the time, delete the key:
Time Counter=XXXX

[Program Setup] section
; Use chart numbers in name. For BSB/KAP and GEO/NOS files, the chart number will
; be added to the chart name. Useful if charts have the same name but different numbers.
; Default is 0, Off. 1 is On. Used by MapCal. If changed you must recreate the Autoload list.
Use Chart Numbers=0
;How SeaClear handles checksums from the NMEA device. Restart SeaClear if changed.
NMEA CheckSum=1
; 0 = Force use of Checksum, empty not accepted
; 1 = Accept empty checksums, use checksum if available  (Default)
; 2 = do not check NMEA checksum
; Default warning sound  .wav file:
; If no path is specified, it is assumed to be located in the Windows directory.
Sound1=DING.WAV
; To replace default sound with other .wav file:
Sound XTE R=FileName   ; For XTE Right Warning Sound
Sound XTE L= FileName   ; For XTE Left Warning Sound
Sound NMEA= FileName   ; For No NMEA Warning Sound
Sound Dpt=FileName        ; For Depth Warning Sound
; To use Magnetic Variation from GPS
MagErr Calc=0
;You can capture selected NMEA sentences to a file. Any NMEA messages may be captured, even 
those not used by SeaClear:
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NMEA_CAPTFILE=C:\NMEACAPT.TXT ; Your capture file
NMEA_CAPTMSG=RMC,GGA,VTG,DBT ; Captured messages. Use "*"' to capture all messages
;You can simulate the GPS data from a file. No NMEA input may be present:
NMEA_SIMUL=C:\NMEAINP1.TXT
; Changing the WCI/KAP/NOS disk buffer. Default 1/8 of computer RAM, or max 16 Mb. In Kb.
; Should normally not be changed.
Diskmap Buffer=16384
; Changing max WCI image size when full image is loaded in memory. Default set to same as
; Diskmap Buffer. Set to 0 speeds up initial loading time of smaller charts but may slow down
; panning and zooming. In Kb. 
Diskmap ImageMem=16384

[Fuel Data] section
Fuel consumption may be estimated. Enter values for speed and fuel consumption/hour in the [Fuel 
Data] section as "speed=fuel-consumption". Both speed and fuel/H is entered with times 10 without 
the decimal. Speed must be entered with 3 digits with leading zeros. Max 20 entries. The 2 closest 
values are used to calculate current fuel consumption. Fuel is displayed in the log and time panel. To 
disable fuel display, rename or comment out the [Fuel Data] section.

Sample:
If your boats fuel consumption is as follow:
2.8 l/h @ 0.0Kt (Idle)
4.5 l/h @ 5.0Kt
8.0 l/h @ 8.0Kt
22.5 l/h @ 14.0Kt
35.0 l/h @ 18.0Kt
65.0 l.h @ 25.0Kt

Enter the following in the INI file:
[Fuel Data]
000=28
050=45 
080=80 
140=225
180=350
250=650

Command line arguments
SeaClear recognize the following command line arguments:
/Ixxxx   where xxxx is the filename of an alternate INI file, including full path.
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SeaClear License
(Wird nicht übersetzt da nur die Englische Original Version der Lizenz Gültigkeit hat! Sollten sie sich 
nicht mit den Lizenzbestimmungen einverstanden erklären ist eine Nutzung und jeder weitere 
Gebrauch der Software nicht erlaubt)
By using or redistributing the SeaClear Software, you agree to all parts of the SeaClear License.
You are granted a non-exclusive license to use the SeaClear Software subject to the following terms 
and conditions:

SeaClear is fully proprietary copyrighted software. Sping AB asserts the right to be recognized as 
the owner, author and copyright owner under International Treaty and Copyright Law.
SeaClear is provided 'as-is', without any warranty, expressed or implied. In no event will the author 
be held liable for any damages arising from the use of this software.
Local law and regulation may restrict the use of electronic navigation software. Always follow local 
regulations and have original charts and appropriate navigation equipment available when using 
SeaClear.
SeaClear must never unattended send information to any device controlling the boat.

You may redistribute SeaClear Software to any person or organization provided that:
You do not charge for the SeaClear Software as a stand-alone product, or charge for products 
where the SeaClear Software is included without explicit prior written permission from Sping AB.
You do not claim to represent ownership or title on, or affiliation with, the SeaClear Software.
You supply the SeaClear Software package complete and unmodified, including this document.

SeaClear is only a navigational aid. It collects, calculates and displays data for you, but there 
is no guarantee it is correct, there are many sources for errors. SeaClear is not a replacement 
for navigational knowledge, nor can it navigate by it self. Use it with care. Always have the 
original charts available when SeaClear is in use.
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